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Introduction: Quantification and morphological assessment of various tissue elements have numerous applications in fundamental and clini-
cal research. Digital morphometry, in contrast to other morphologic methods, uses personal computers and specific software, to perform 
precise and highly reproducible results. Additionally, it delivers results in mathematical format. The aim of our study was to develop an open 
access digital morphometry method for measuring different parameters of various high contrast tissue elements and to elaborate a general 
work-around for digital morphometry study and data management.
Materials and methods: We used three different types of tissue samples and staining procedures: (1) Diffuse Large B-cell Lymphoma 
specimens, (2) various stage liver fibrosis specimens and (3) transversely sectioned skeletal muscle tissue to develop a digital morphometric 
analysis. Image analysis was performed using ImageJ software. 
Results: We developed an intuitive and easy to use work-algorithm that fits generic demands. We split the algorithm into three phases, each 
requiring a different approach and workaround. Using the presented method we were able to quantify the proportion of CD34 positive areas in 
the DLBCL specimens, the vascularity of this type of lymphoma may be quantified; similarly, this method is optimal for determining the exten-
sion of fibrosis in liver specimens; and finally, morphometric analysis of striated muscle fibers was achieved. 
Conclusions: We conclude that the use of ImageJ with semiautomatic color segmentation is a reliable and practical way of performing vari-
ous morphometric measurements. In addition, we are confident that such methods of digital morphometry could have future applications in 
other areas of pathology and histology.
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Introduction
Quantification and morphological assessment of various 
tissue elements have numerous applications in fundamen-
tal and clinical research [1]. Digital morphometry, with 
the use of computer assisted image analysis techniques, in 
contrast to other morphologic methods, permits the use 
of personal computers and available software, dedicated 
or not, to perform precise and highly reproducible results. 
Additionally, it delivers results in mathematical format. 
Not surprisingly, many researchers in the field of pathol-
ogy or other related sciences embraced these techniques 
and used them in different settings. Some frequently used 
morphometric parameters include: shape descriptors, de-
scriptors of gray value distribution, descriptors of the size 
and localization of various image segments and particle 
count. Introduction of morphometric procedures into 
research greatly enhanced the reproducibility of various 
morphometric studies and their results. There are many 
instances where specific areas of certain tissue sections 
need to be accurately measured and/or described using 
various parameters such as dimension, number and ra-
tio to other tissue elements. Digital morphometry spans 
a wide area of applications and its literature is growing 
constantly [2–8].

Many methods used by various research groups use 
proprietary software solutions that sometimes require 
expensive license. On the other hand, most of these also 
require advanced computer operating skills and at times 
even programming skills in various programming environ-

ments, therefore making them even more difficult to access 
by researchers. We listed some of the proprietary software 
used in digital image analysis in table I [10–18].

The aim of our study was (1) to develop an open access 
digital morphometry method for measuring different pa-
rameters of various high contrast tissue elements and (2) to 
elaborate a general work-around for digital morphometry 
study and data management. The purpose of the method 
would be to enable the user to quickly and reliably meas-
ure the number, size and extension of a given tissue area 
marked with a specific dye or DAB, using digital micro-
scopic images.

Material and methods

Specimen selection, staining and  
immunohistochemistry
In order to extend our method's usability we used three 
different types of tissue samples and staining procedures: 
(1) Diffuse Large B-cell Lymphoma specimens, (2) various 
stage liver fibrosis specimens and (3) transversely sectioned 
skeletal muscle tissue (see Figures 1–3). For each type of 
lesion/tissue a number of 20 cases were selected.

All histological sections were fixed in 4% neutral for-
maldehyde solution and later paraffin-embedded. The 
approximately 3–5 µm thick sections were deparaffinised 
by xylene-ethanol sequence. Diffuse Large B-cell Lym-
phoma specimens were selected from a previous study 
and vascular elements were highlighted using CD34 an-
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tibody (Class II, clone QBEnd 10, Dako, Denmark). Ap-
plication of the primary antibody was followed by the 
two-step peroxidase technique. The staining process was 
achieved using DAB chromogen. Various stage liver fi-
brosis specimens were stained using Masson's trichrome 
stain and were obtained from another study regarding liv-
er fibrosis. Finally, transversely sectioned skeletal muscle 
tissue samples were obtained from gastrocnemian muscles 
of AKR mice.

Image acquisition
Digital slides were made with Zeiss MiraxScan digital 
slide acquisition system (Carl Zeiss Jena GmbH, Jena 
Germany) mounted with Marlin F-146C digital camera 
at a resolution of 1392×1040 pixels with Sony ICX267 
sensor (Allied Vision Technologies GmbH, Stadtroda Ger-
many) through Zeiss Plan-Apochromat 20× magnifica-
tion and 0.8 numeric aperture. The acquisition system was 
controlled by MiraxScan software (3DHistech, Budapest, 
Hungary) installed on a Fujitsu-Siemens Celsius Worksta-
tion computer (4 × 2 GHz CPU, 2 GB RAM).

For each tissue type, a number of 5 images / specimen 
were saved from the digital slides both in TIFF (Tagged 
Image File Format) and JPG (Joint Photographic Experts 
Group) format using the 3DHistech Panoramic Viewer. 

Thus, a total number of 300 digital images were prepared 
for the study. Digital images were not altered in any way 
(contrast, luminosity, levels etc.) before morphometric 
analysis, i.e. they were further used as they were saved by 
the Panoramic Viewer software.

It should be noted that digital image acquisition in our 
laboratory indeed uses proprietary tools as opposed to our 
main goal to develop an open source solution. Neverthe-
less, digital microscopic images may be obtained in many 
ways and it varies greatly among different pathology labo-
ratories where such studies are being performed.

Image processing
Image analysis methods were performed using ImageJ 
software, version 1.44c (developed by Wayne Rasband, 
National Institutes of Health, Bethesda, Maryland, USA) 
[19] and Java 1.6.0_20 (32-bit) engine. We deliberately 
choose this software since it is freely available and is plat-
form independent. Additionally, we used the color thresh-
olding image adjustment employing the Threshold_Col-
our plugin (now included in the ij.jar). This plugin is a 
modification of Bob Dougherty's BandPass2 filter [20]. All 
image processing was performed on a DualCore (2 × 2.2 
Ghz), 2 Gb memory PC running alternatively Microsoft 7 
and Ubuntu 10.10 (Linux Kernel 2.6.35-28).

Fig. 1.  Tissue specimen from a DLBCL case marked for CD34 
antibody, immunohistochemistry, DAB chromogen Fig. 2.  Liver tissue section stained with trischrome stain

Table I.  Some of the software used in digital image analysis by various researchers

Author Application Software Vendor Ref

Garton et al. (2010) Skeletal muscle fiber analysis MetaMorph SPOT Imaging Solutions (Diagnostic Instruments, 
Inc.) Sterling Heights, MI, USA

10

Garton et al. (2010) Skeletal muscle fiber analysis ImagePro Plus 2.0 Media Cybernetics, Silver Spring, MD 10

Krajewska et al. (2009) Cell death and fibrosis assessment ImageScope Aperio Technologies, Inc., USA 11

Hall et al. (2008) HER2 analysis Matlab The MathWorks, Inc. Natwick, MA, USA 12

Ficsor et al. (2008) Colon Microsoft Visual C++ Microsoft 13

Caruntu, Covici (2006) Renal corpuscle Zeiss KS400 Carl Zeiss Jena GmbH, Jena Germany 14

Weaver et al. (2003) Sentinel Lymph Node Micrometasta-
ses in Breast Cancer

ChromaVision Automated 
Cell Imaging System

ChromaVision Medical Systems, Inc., San Juan 
Capistrano, CA , USA

15

Căruntu et. al (2002) Dental tissue Zeiss KS400 Carl Zeiss Jena GmbH, Jena Germany 16

Lehr et al. (2001) HER 2 analysis Photoshop Adobe Systems Incorporated, San Jose, CA, USA 17

Francis et al. (2000) Breast carcinoma CAS-200 Becton Dickinson, Elmhurst, Illinois, USA 18
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Results. Description of the method
In order to achieve the desired goals we found the follow-
ing work-algorithm most lucrative and best fit for generic 
digital morphometric studies (see Figure 4) as well as for 
our aims. We split the algorithm into three phases, each 
requiring different approach and workaround. 

Phase one is the most frequently overlooked, however, 
we consider it the most critical amongst the other work 
phases in any digital morphometric study. It represents 
the moment when one should turn off the computer and 
instead look into the microscope and carefully determine 

what can possibly be measured using digital morphometry. 
Our method requires that the measured areas be of high 
contrast and have significantly different hues. Keeping this 
in mind helps the user to minimize error and quantifica-
tion of parameters that in fact cannot be measured. This is 
the reason why we specially developed this method for im-

Fig. 4.  Visual representation of the phases of digital image analy-
sis of our study

Fig. 5.  The effects of digital image processing on various tissue samples using color segmentation, thresholding (A: Diffuse Large B-cell 
Lymphoma specimens with IHC staining for CD34 antibody; B: liver fibrosis specimen; C: transversely sectioned skeletal muscle tissue 
sample). Note: the last column of images are mounted images to show what was actually measured.

Fig. 3.  Mouse skeletal muscle fibers (transverse section), 
haematoxylin-eosin stain
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munohistochemical DAB (3,3'-Diaminobenzidine) stain, 
Masson's trichrome stain and selected cases of haemato-
xylin-eosin stain. It is hard to establish a list of applica-
tions that can be used with our method since it can be 
highly customized. Nevertheless it is important to set from 
the beginning those parameters that are to be measured; 
these parameters may include: specific object area, color 
and number.

Phase two includes the digital image acquisition and 
morphometric procedures. Image acquisition is important 
since we found that it can significantly influence the out-
come of the results. During image acquisition the examin-
er arbitrarily picks usually up to 5 digital images per tissue 
section to have digital morphometry performed on. It is 
obvious that these images have to be chosen very carefully 
in order to best describe the tissue section as a whole. In 
this regard a thorough analysis of the whole tissue section is 
necessary by visual inspection in order to be able to choose 
those fields that best describe the entire tissue. In the case 
of DLBCL with CD34 IHC labeling it is relatively easy 
to pick such fields since the whole lymph node is equally 
affected by the disease and the analysis of different regions 
will have similar results. In case of liver fibrosis inspection 
of the whole tissue sample is mandatory in order not to 
over- or underestimate the extension of fibrosis. Regarding 
striated muscle fibers the cave out is to choose fibers that 
are perfectly perpendicular to the sectioning plane. 

Morphometric procedures comprise several steps that 
include HSB-based color segmentation and particle analy-
sis. The end result is the analysis of those areas that were 
“separated” (through color segmentation) from the origi-
nal tissue based on their HSB characteristics. The typical 
image processing steps are presented in Figure 5. In the 
following section we describe the step-by-step procedure. 

After launching ImageJ picture editor and processing 
tool, the desired microscopic digital image is opened ei-
ther by File > Open or by simply dragging the image 
to ImageJ's toolbar. Once the image is open it may be seg-
mented based on HSB parameters using Image > Ad-
just > Color Threshold. (Note that this feature is 
relatively new to ImageJ, earlier versions needed to install 
the additional Threshold_Colour plugin). A separate win-
dow appears displaying three histograms default for Hue, 
Saturation and Brightness. Using this window the user 
may filter those areas that need to be measured. Filtering 
is achieved by setting the minimum and maximum for the 
HSB filters and specifying whether a specific filter passes 
or stops (Pass/Stop) a certain spectrum range. For the three 
chosen specimens we found the settings presented in Table 
II to be typical for color thresholding. After the desired 
areas remain visible and the rest of the tissue obscured by 
pressing Threshold on the Threshold Color window all 
filtered areas are displayed in foreground color (typically 
black) and non-filtered areas as background color (typi-
cally white). Foreground/background color settings may 
be changed accessing Edit > Options > Colors. 
Thresholding is a key step in HSB-based image processing 
since it is up to the user to set which tissue areas remain 
visible and remain obscure. We found that best results are 
obtained using thin sections and high quality images. After 
thresholding is performed, in order for the next step to be 
applicable, the resulted image must be converted to 8-bit 
format (Image > Type > 8-bit), regardless of initial 
format. Before particle count the user must set which pa-
rameters are to be measured (Analyze > Set Measure-
ments), see Figure 6. For typical morphometric analysis 

Fig. 6.  ImageJ's Set Measurements settings panel

Fig. 7.  ImageJ's Analyze Particles initial setting panel

Table II.  Typical settings for color thresholding for the three tissue 
samples, numbers indicate minimum and maximum values while 
letters in brackets indicate filter type (P – pass; S – stop)

Tissue and stain Hue Saturation Brightness

DLBCL (DAB) 44/255 (S) 37/255 (P) 0/255 (P)

Liver (Masson's trichrome) 0/216 (P) 56/255 (P) 0/255 (P)

Muscle (haematoxylin-eosin 0/217 (S) 112/255 (P) 0/255 (P)
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area, area fraction, perimeter, Ferret's diameter will suffice. 
After marking the desired measurements, particle analysis 
may be performed on the thresholded image (Analyze 
> Analyze Particles), Figure 7. The initial panel has 
some key settings worth mentioning. Size limits the size 
of the particles measured. If the thresholded image con-
tains too much background noise or „grain”, setting mini-
mum particle size other than zero will exclude much of 
this noise. The minimum particle size to be excluded is 
best determined empirically. For optimal results Display 
results, Clear results, Summarize, Exclude on edges must 
be checked. This part of the image processing is entirely 
automatic since particle count and analysis is performed 
by ImageJ.

Phase three consists of data saving and management 
and begins after particle analysis is performed. After per-
forming phase two of the image analysis, all filtered tis-
sue areas measured (and their parameters) and included in 
a tabulated data format. ImageJ displays the results in a 
separate window (Results) that may be saved in one of 
the popular data storage file formats (e.g. csv or xls). This 
data is then available for further statistical analysis and data 
mining.

Using the presented method we were able to quanti-
fy the proportion of CD34 positive areas in the DLBCL 
specimens. Assuming that most CD34 areas correspond 
to endothelial structures, the vascularity of this type of 
lymphoma may be quantified. Similarly, this method is 
optimal for determining the extension of fibrosis in the 
examined liver specimens. Finally, the perimeter and Fer-
ret's diameter were measured for the striated muscle fibers. 
These parameters are used to compare changes in muscle 
fiber diameter after drug administration to ARK mice.

Discussions
In our paper we presented a practical approach and work-
algorithm to perform Hue-Saturation-Brightness based 
image analysis of high contrast tissue components. We 
have chosen a software (ImageJ) that is freely available 
along with extensive documentation [19,20]. This soft-
ware is platform independent, therefore it may be used on 
any operating system that is bundled with Java Engine. 
Additionally we presented the required steps in order to 
perform the method. As we stated in the introduction, 
our goal was to develop an accessible work-flow devoid 
of too many technical terms so that advanced program-
ming knowledge is not a requirement. This method is by 
far not intended to provide an all-in-one image analysis 
tool, but rather a starting point in performing more com-
plex digital image morphometric analysis. Its ImageJ based 
core methodology renders this method highly customiz-
able and adaptable to various demands. In the spirit of 
open source we provide additional information and also 
the complete set of functions and procedures of phase 
two on our continuously updated webpage, located at  
pathologia.ro/morphometry.

Conclusions
We conclude that the use of ImageJ with semiautomatic 
color segmentation is a reliable and practical way of per-
forming various morphometric measurements. In addi-
tion, we are confident that such methods of digital mor-
phometry could have future applications in other areas of 
pathology and histology. This is mainly due to the fact that 
the method that we presented uses an open source software 
environment that is available to everyone and extensive 
documentation exists on the Internet.
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